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Dans ce manuel...
Ce manuel explique comment installer le logiciel ChemStation, comment 
ajouter d’autres instruments à un système existant, comment configurer votre 
système d’analyse et comment vérifier que l’installation et la configuration 
sont complètes et correctes.

Résumé des chapitres du manuel :

1 - Préparation de l’installation - Ce chapitre présente les grandes lignes 
de la ChemStation Agilent Technologies. Il récapitule la configuration 
PC requise, indique les exigences en cas de mise à niveau et fournit 
différentes informations à propos des communications avec les 
instruments.

2 - Installation de la ChemStation Agilent - Ce chapitre décrit les procédures 
d’installation et de mise à niveau du logiciel ChemStation Agilent. 

3 - Configuration des instruments - Ce chapitre explique comment utiliser 
l’éditeur de configuration pour configurer vos instruments.

4 - Validation et démarrage de la ChemStation Agilent - Ce chapitre décrit 
comment valider et commencer à utiliser le logiciel ChemStation 
Agilent.

5 - Ressources supplémentaires - Ce chapitre décrit les ressources 
supplémentaires ChemStation Agilent disponibles sur le DVD 
ChemStation Agilent et sur le web.

Ce manuel suppose :

• Que vous soyez familiarisé avec les systèmes d’exploitation Microsoft® 
Windows XP Professionnel ou Microsoft® Windows Vista™ Professionnel ;

• Que vous installiez le logiciel sur un PC répondant aux exigences 
matérielles minimales ;

• Que vos instruments et appareils de communication soient compatibles 
avec la présente version de la ChemStation Agilent.

Le logiciel ChemStation Agilent communique avec les équipements d’analyse 
via des communications de données LAN (réseau local) ou GPIB (bus 
d’interface général).



4 Installation de votre ChemStation



Installation de votre ChemStation 5

Table des matières

1 Préparation de l’installation

Configuration de l’ordinateur      8

À propos du réseau local      11

Communication avec les instruments      12

Définition des adresses IP sur le CPG      14

Installation du service BootP Agilent      17

Installation et configuration de la carte d’interface 
GPIB Agilent      25

2 Installation de la ChemStation Agilent

Avant de commencer      28

Procédure d’installation      29

Ajout d’instruments à une installation existante      35

Installation des rapports des graphiques de contrôle      36

3 Configuration des instruments

À propos de l’éditeur de configuration ChemStation Agilent      38

Configuration de la ChemStation Agilent pour les systèmes 
CPG (7890A, 6890, 6850 et 5890/4890)      39

Configuration de la ChemStation Agilent pour systèmes 
de traitement de données      43

Configuration de la ChemStation Agilent pour systèmes 
d’interface A/N 35900E      45

Modification des chemins d’accès aux fichiers de méthodes, 
de séquences et de données      51



6 Installation de votre ChemStation

4 Validation et démarrage de la ChemStation Agilent

Application IQT (Installation Qualification Report)      54

Qualification opérationnelle/vérification de 
performances (OQ/PV)      58

5 Ressources supplémentaires

Centre de Contact Client Agilent Technologies      60

Contenu du DVD ChemStation Agilent      62

Produits de formation      64

Système d’aide de la ChemStation Agilent      65

Logiciel Agilent Lab Advisor      66

Plus d’informations      66

Index



7

Agilent ChemStation pour systèmes CPG, traitement des données et 
convertisseur A/N 35900E

Installation de votre ChemStation

Agilent Technologies

1
Préparation de l’installation

Configuration de l’ordinateur    8

À propos du réseau local    11

Communication avec les instruments    12

Définition des adresses IP sur le CPG    14

Configuration de l’adresse IP pour le CPG Agilent 7890A    14

Configuration de l’adresse IP pour le CPG Agilent 6890N    15

Configuration de l’adresse IP du CPG Agilent 6850    16

Installation du service BootP Agilent    17

Installation et configuration de la carte d’interface GPIB Agilent    25

Ce chapitre a pour objectif de vous présenter la ChemStation d’Agilent 
Technologies. Il récapitule la configuration PC requise, indique les exigences 
en cas de mise à niveau et fournit différentes informations à propos des 
communications avec les instruments. 
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1 Préparation de l’installation

Configuration de l’ordinateur

Voici la configuration matérielle minimale requise pour pouvoir installer 
le logiciel ChemStation Agilent Technologies (version B.04.02) :
• Un ordinateur personnel doté d’un processeur Intel Pentium IV  

(1,5 GHz pour Microsoft Windows XP Professionnel) 
(3,4 GHz single core pour Microsoft Windows Vista)

• Ecran Super VGA 1280 x 1024, 16 000 couleurs ou résolution supérieure

• Disque dur de 40 Go pour Microsoft Windows XP Professionnel ou 
de 160 Go pour Microsoft Windows Vista

• Lecteur de DVD

• 512 Mo de mémoire vive pour Windows XP Professionnel, 1 Go de mémoire 
vive pour Windows Vista

• Dispositif de pointage compatible Microsoft Windows

• Imprimante compatible avec le système d’exploitation. Pour les systèmes 
anglais utilisant le langage PCL 5c, 5e, 5e, 5.02 ou 6, pour les systèmes 
chinois utilisant le langage PCL 6 et pour les systèmes japonais, consulter 
le Tableau 1.

• Système d’exploitation Microsoft Windows XP Professionnel (Service 
Pack 3) ou Microsoft Windows Vista Professionnel (Service Pack 1) 
(uniquement en anglais, chinois ou japonais). 

• Protocole TCP/IP installé si vous utilisez des communications LAN.

• Pour les communications GPIB, vous devez utiliser soit l’adaptateur USB 
GPIB 82357B, soit la carte PCI GPIB 82350B, ainsi que le logiciel I/O 
Library Suite 15.0. Consultez le répertoire Manuals du DVD ChemStation 
pour obtenir les instructions relatives à l’installation d’Agilent I/O 
Library Suite.

Tout le matériel PC, ainsi que ses périphériques, doivent figurer parmi la liste 
de compatibilité matérielle (Hardware Compatibility List, HCL) de Microsoft, 
accessible depuis la page d’accueil du site Microsoft, à l’adresse 
http://www.microsoft.com. Si les composants matériels de votre PC ne 
figurent pas dans cette liste, il se peut que le logiciel ChemStation Agilent 
ne fonctionne pas correctement.
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Ordinateurs non HP

La ChemStation est conçue pour fonctionner sur un grand nombre de PC 
compatibles, équipés d’accessoires et de périphériques conformes aux normes 
de programmation de la plate-forme PC Intel et des systèmes d’exploitation 
Microsoft Windows. 

Toutefois, Agilent a testé le logiciel ChemStation essentiellement sur du 
matériel Hewlett-Packard (HP)/Compaq. La configuration standard de 
l’interface GPIB, par exemple, peut être incompatible avec la configuration 
mémoire d’un ordinateur autre que HP. Les cartes d’interface auxiliaires 
supplémentaires peuvent être à l’origine de conflits avec les ressources 
matérielles (ports d’E/S, lignes d’interruption, canaux DMA). 

Si votre ordinateur n’est pas de marque HP, servez-vous des utilitaires fournis 
par le fabricant pour le configurer. Reportez-vous à la documentation livrée 
avec l’ordinateur et ses accessoires pour éviter tout conflit de ressources, 
notamment pour la configuration de l’interface GPIB.

Imprimantes pour la ChemStation Agilent

La ChemStation Agilent est conçue pour fonctionner avec des imprimantes 
compatibles avec le système d’exploitation. Ces imprimantes doivent être 
connectées à un port local (de préférence parallèle) ou à un port réseau sur 
le PC. Les imprimantes avec port série sont prises en charge par le système 
d’exploitation, mais elles peuvent présenter des limitations de vitesse. 
Les imprimantes en réseau doivent être partagées via un serveur réseau 
fonctionnant avec un protocole réseau compatible avec le système 
d’exploitation Microsoft. Nous recommandons d’utiliser des imprimantes 
capables d’interpréter un langage à codes d’échappement (par exemple PCL) 
ou un langage de description de pages (par exemple PostScript®). Les 
imprimantes gérées par un système central (telles que les imprimantes GDI 
-Graphical Device Interface- ou PPA -Printer Performance Architecture-) 
imposant plus de tâches de traitement d’impression à l’unité centrale, il est 
déconseillé de les utiliser en direct avec la ChemStation. 

Pour obtenir les meilleurs résultats possibles avec votre ChemStation Agilent, 
utilisez les imprimantes HP LaserJet (voir Tableau 1). Vous pouvez aussi 
utiliser les imprimantes HP DeskJet hautes performances si les volumes 
d’impression sont faibles. Consultez les fichiers readme.txt pour obtenir des 
informations sur les versions des pilotes d’imprimante recommandées. Agilent 
n’a pas testé toutes les combinaisons d’imprimantes et de pilotes possibles 
dans l’environnement Windows. Les performances et la qualité de 
l’impression peuvent varier suivant le fabricant de l’imprimante.
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Tableau 1 Imprimantes testées et déclarées compatibles avec la ChemStation Agilent 
version B.04.02

Imprimante Modèle Pilote

HP LaserJet 4050 et 4100 Pilote HP PCL 5e ou PCL 6

HP LaserJet 4200 Pilote HP PCL 5e ou PCL 6

HP LaserJet 4250 Pilote HP PCL 6

HP LaserJet P3005D Pilote HP PCL 6

HP Color LaserJet 2500TN Pilote HP PCL 6

HP OfficeJet Pro K550DTWN Pilote HP PCL 3

HP OfficeJet Pro K5400

HP LaserJet 2200D Pilote HP PCL 5.02 ou PCL 6

HP LaserJet 2300DN Pilote HP PCL 5e ou PCL 6

HP LaserJet 2420D Pilote HP PCL 6
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À propos du réseau local

Pour utiliser la ChemStation Agilent, vous devez disposer sur votre PC du 
protocole réseau TCP/IP. 

Avec les systèmes Agilent 6890 Plus, 6890A ou 35900E, les cartes réseau 
J4100A JetDirect et G1369A utilisées pour connecter ces instruments 
d’analyse nécessitent le protocole d’amorçage BootP. Agilent ne prend en 
charge que le service d’amorçage BootP Agilent fourni à cet effet sur le 
DVD ChemStation.

La version B.04.02 du logiciel ChemStation Agilent propose des fonctions de 
contrôle d’instruments et d’acquisition de données gérées par le réseau local 
pour les instruments de CPG et les convertisseurs A/N Agilent en réseau. Vous 
pouvez facilement piloter et surveiller les instruments en les connectant au 
réseau local sur lequel réside le PC de la ChemStation Agilent. Cela permet de 
placer le PC de la ChemStation Agilent dans un rayon de 100 mètres autour 
des instruments qu’il contrôle sur un réseau local autonome pris en charge 
par Agilent, ou partout dans le monde sur un réseau TCP/IP pris en charge 
par votre administrateur réseau.

Chaque ChemStation Agilent permet de prendre en charge jusqu’à quatre 
instruments sur le réseau local. Chaque appareil du réseau local nécessite une 
adresse IP unique, un masque de sous-réseau et une passerelle par défaut.

En cas d’installation de la ChemStation Agilent sur un réseau local sur site, 
contactez l’administrateur de ce réseau.

La ChemStation Agilent prend en charge les instruments et ordinateurs ayant 
des adresses fixes auto-attribuées ou des adresses attribuées par le service 
BootP Agilent (voir « Installation du service BootP Agilent », page 17). 
Le protocole DHCP n’est pas pris en charge par Agilent.
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Communication avec les instruments

La ChemStation Agilent communique avec les CPG par le biais d’une interface 
de communication LAN ou GPIB.

Veillez à configurer le canal de communication entre l’instrument et le PC 
avant d’utiliser le système. 

Pour plus de détails sur l’installation d’une carte réseau sur votre PC ou sur 
un instrument piloté par la ChemStation Agilent, consultez la documentation 
de la carte.

Communications sur le réseau local

Reportez-vous au numéro de page mentionné dans le Tableau 2 pour en savoir 
plus sur la configuration du matériel et des logiciels de communication 
correspondant à votre système.

Tableau 2 Interfaces de communication LAN prises en charge par la ChemStation Agilent 

Type d’instrument Modèle

Version du 
microprogramme 
prise en charge

Méthode 
d’adressage IP 
prise en charge Voir :

7890A G3440A A.01.10.1 Définie sur le 
CPG 

page 14

CPG 6890N G1530N/ 
G1540N

N.06.05 pour 7693A 
ou N.05.06  
(montage LAN 04.7B3)

Définie sur le 
CPG 

page 15

6890 Plus, 6890A G1530A/ 
G1540A

A.03.08 Service Agilent 
BootP

page 20

CPG 6850  
SN ≥ US10243001

G2630A N.06.03 pour 7693A 
ou A.05.04 
(montage LAN 04.7B3)

Définie sur le 
CPG 

page 16

CPG 6850  
SN ≤ US00003200

G2630A N.03.05 pour 7693A 
ou A.03.03

Définie sur le 
CPG ou  
Service BootP 
Agilent 

page 16 
page 20

35900E 35900E E.01.02 Service BootP 
Agilent

page 20
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Communication GPIB

Les instruments d’analyse qui communiquent avec la ChemStation Agilent par 
un bus GPIB nécessitent l’installation sur l’ordinateur d’une carte d’interface 
GPIB. Consultez le Tableau 3 pour obtenir la liste des types d’instruments 
utilisant la communication GPIB et compatibles avec la carte d’interface 
82350B et la carte d’interface USB-GPIB 82357B.

Reportez-vous à la section « Installation et configuration de la carte d’interface 
GPIB Agilent », page 25 pour plus de détails sur la configuration du matériel 
GPIB. Pour savoir comment installer et configurer Agilent IO Libraries Suite 
15.0, reportez-vous aux instructions d’installation et de configuration 
proposées dans le dossier Support\Manuals\Dossier d’installation du DVD 
ChemStation.

Tableau 3 Tableau de compatibilité GPIB/instruments d’analyse chimique 

Type d’instrument Modèle
Version du microprogramme 
prise en charge

Agilent
82357B

Agilent 
82350B

6890 Plus, 6890A G1530A/ 
G1540A

A.03.08 Oui Oui

5890 série II 5890 A.03.02 Oui Oui

4890D G2690A A.01.01 Oui Oui

7890A Non Non

6850 Non Non

6890N Non Non

35900E Non Non
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Définition des adresses IP sur le CPG

Cette section explique comment définir l’adresse IP d’un CPG sur le clavier 
de l’instrument. Si cette fonction n’est pas disponible sur votre CPG, 
reportez-vous à la section « Installation du service BootP Agilent », page 17.

Configuration de l’adresse IP pour le CPG Agilent 7890A

Cette procédure concerne le CPG Agilent 7890A.
1 Sur le clavier du 7890A, appuyez sur Options. Sélectionnez Communication 

et appuyez sur Enter (Entrée). L’écran suivant apparaît :

COMMUNICATION SETPTS 
---- LAN ---- 
IP: 000.000.000.000 
GW: 000.000.000.000 
SM: 000.000.000.000 
Enable DHCP OFF 
Reboot GC 
Adresse MAC

2 Saisissez l’adresse IP du CPG 7890A (blocs de chiffres séparés par des 
points) et appuyez sur Enter (Entrée).* Le CPG affiche un message vous 
demandant d’éteindre et de rallumer l’instrument. Attendez avant 
d’éteindre l’appareil. Appuyez sur Clear (Effacer).

3 Passez à l’option GW (Passerelle). Saisissez le numéro de passerelle et 
appuyez sur Enter (Entrée). Le 7890A affiche un message vous demandant 
d’éteindre et de rallumer l’instrument. Attendez avant d’éteindre l’appareil. 
Appuyez sur Clear (Effacer).

4 Sélectionnez SM (Masque de sous-réseau) et appuyez sur Mode/Type. 
Dans la liste des modes, sélectionnez le masque de sous-réseau approprié 
et appuyez sur Enter (Entrée). Le 7890A affiche un message vous demandant 
d’éteindre et de rallumer l’instrument. Attendez avant d’éteindre l’appareil.

5 Sélectionnez l’option Reboot GC (Redémarrer le CPG) et appuyez sur On/Yes 
(Marche/Oui) pour éteindre puis rallumer l’instrument et appliquer les 
points de consigne LAN à la carte.

6 Appuyez sur Options. Sélectionnez Communications et appuyez sur Enter 
(Entrée). Vérifiez les points de consigne.

* Si vous ignorez l’adresse IP ou les paramètres de passerelle ou de masque de sous-réseau 
correspondant à l’ordinateur où est installée la ChemStation Agilent, Agilent recommande de 
définir l’adresse IP par défaut sur 10.1.1.100 pour le PC, sur une adresse comprise entre 10.1.1.101 
et 10.1.1.105 pour le module de contrôle CPG ou A/N, sur 10.1.1.100 pour la passerelle et sur 
255.255.255.0 pour le masque de sous-réseau.
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Configuration de l’adresse IP pour le CPG Agilent 6890N

Cette procédure concerne le CPG Agilent 6890N (avec montage LAN).

1 Sur le clavier du 6890N, appuyez sur Options. Sélectionnez Communication et 
appuyez sur Enter (Entrée). L’écran suivant apparaît : 

COMMUNICATION SETPTS 
---- LAN ---- 
IP: 000.000.000.000 
GW: 000.000.000.000 
SM: 000.000.000.000 
Enable DHCP OFF

---- RS-232 ---- 

2 Saisissez l’adresse IP de votre 6890N en séparant les blocs de chiffres par 
des points, puis appuyez sur Enter (Entrée).* Le CPG affiche un message 
vous demandant d’éteindre et de rallumer l’instrument. Attendez avant 
d’éteindre l’appareil. Appuyez sur Clear (Effacer).

3 Passez à l’option GW (Passerelle). Saisissez le numéro de passerelle et 
appuyez sur Enter (Entrée). Le 6890N affiche un message vous demandant 
d’éteindre et de rallumer l’instrument. Attendez avant d’éteindre l’appareil. 
Appuyez sur Clear (Effacer).

4 Sélectionnez SM (Masque de sous-réseau) et appuyez sur Mode/Type. Dans 
la liste des modes, sélectionnez le masque de sous-réseau approprié et 
appuyez sur Enter (Entrée). Le 6890N affiche un message vous demandant 
d’éteindre et de rallumer l’instrument.

5 Eteignez et rallumez l’instrument pour appliquer les points de consigne 
LAN à la carte.

6 Appuyez sur Options. Sélectionnez Communications et appuyez sur Enter 
(Entrée). Vérifiez les points de consigne.

* Si vous ignorez l’adresse IP ou les paramètres de passerelle ou de masque de sous-réseau 
correspondant à l’ordinateur où est installée la ChemStation Agilent, Agilent recommande de 
définir l’adresse IP par défaut sur 10.1.1.100 pour le PC, sur une adresse comprise entre 10.1.1.101 
et 10.1.1.105 pour le module de contrôle CPG ou A/N, sur 10.1.1.100 pour la passerelle et sur 
255.255.255.0 pour le masque de sous-réseau.
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Configuration de l’adresse IP du CPG Agilent 6850 

Cette procédure concerne le CPG série 6850 (avec montage LAN).

1 Eteignez le CPG.

2 Appuyez sur LOAD (CHARGEMENT) et, tout en maintenant cette touche 
enfoncée, allumez le CPG. Continuez à maintenir la touche LOAD 
(CHARGEMENT) enfoncée jusqu’à ce que cinq points apparaissent à l’écran.

3 Lorsque le CPG démarre, vous devez voir apparaître : 
 
DHCP MODE: 
DISABLED 
 
Si le mode DHCP n’est pas paramétré sur DISABLED (DÉSACTIVÉ), appuyez 
sur ▲ ou ▼ pour sélectionner DISABLED (DÉSACTIVÉ). Appuyez sur LOAD 
(CHARGEMENT) pour passer à l’élément suivant.

4 Vous devez alors voir apparaître l’écran suivant : 
 
IP ADDRESS 
XXX.XXX.XXX.XXX 

5 Appuyez sur LOAD (CHARGEMENT) pour modifier les valeurs de l’adresse 
IP. Appuyez sur ▲ ou ▼ pour modifier les valeurs et sur LOAD 
(CHARGEMENT) pour passer d’une valeur à la suivante.* 

6 Dès que vous avez indiqué une adresse IP, l’écran affiche : 
 
DEFAULT GATEWAY 
XXX.XXX.XXX.XXX 

7 Pour modifier la passerelle par défaut, procédez comme pour l’adresse IP.*

8 Modifiez la valeur du masque de sous-réseau de la même manière.*

9 Eteignez et rallumez le CPG pour appliquer les nouveaux paramètres.

* Si vous ignorez l’adresse IP ou les paramètres de passerelle ou de masque de sous-réseau 
correspondant à l’ordinateur où est installée la ChemStation Agilent, Agilent recommande de 
définir l’adresse IP par défaut sur 10.1.1.100 pour le PC, sur une adresse comprise entre 10.1.1.101 
et 10.1.1.105 pour le module de contrôle CPG ou A/N, sur 10.1.1.100 pour la passerelle et sur 
255.255.255.0 pour le masque de sous-réseau.
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Installation du service BootP Agilent

Les cartes réseau JetDirect J4100A et G1369A utilisées pour connecter un 
instrument d’analyse à un réseau local nécessitent le protocole BootP. Agilent 
ne prend en charge que le service d’amorçage BootP Agilent fourni à cet effet 
sur le DVD ChemStation.

Cette section décrit l’installation du logiciel du service BootP Agilent. 
Ce service permet d’attribuer des adresses à tous les appareils qui ne 
peuvent pas s’en attribuer automatiquement.

Objet

Le service BootP Agilent centralise l’administration des adresses IP pour tous 
les instruments Agilent d’un réseau local. Il s’exécute sur le PC réseau de 
l’instrument, lequel doit utiliser le protocole réseau TCP/IP et ne peut abriter 
de serveur DHCP.

À la mise en route d’un instrument, la carte Agilent JetDirect de l’instrument 
transmet une demande d’adresse IP ou de nom d’hôte, et fournit son adresse 
matérielle comme identificateur. La demande peut se poursuivre pendant 
5 minutes. Le service BootP Agilent répond à cette demande et transmet à 
l’instrument demandeur l’adresse IP ainsi que le nom d’hôte précédemment 
définis pour cette adresse matérielle.

Lorsque l’instrument reçoit son adresse IP et son nom d’hôte, il cesse d’émettre 
la demande. Il conserve l’adresse IP tant qu’il est sous tension, mais tout arrêt 
de l’instrument entraînera la perte de l’adresse IP. Le service BootP Agilent doit 
donc être redémarré à chaque mise en route de l’instrument. Étant donné que le 
service BootP Agilent s’exécute en arrière-plan, l’instrument reçoit son adresse 
IP lorsqu’il est mis sous tension.

Adresses

Avant d’installer et de configurer le service BootP Agilent, vous devez 
connaître les adresses IP de l’ordinateur et des instruments, le masque de 
sous-réseau, ainsi que l’adresse de passerelle (reportez-vous au Chapitre 1).
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Installation

Suivez la procédure ci-dessous pour installer le service BootP Agilent.

1 Ouvrez une session en tant qu’administrateur ou utilisateur disposant 
de privilèges d’administrateur.

2 Fermez tous les programmes Windows.

3 Insérez le DVD ChemStation Agilent dans le lecteur. Si le programme 
d’installation démarre automatiquement, cliquez sur Cancel (Annuler) 
pour l’arrêter.

4 Ouvrez Windows Explorer (Explorateur Windows).

5 Double-cliquez sur BootPPackage.msi dans le répertoire BootP du DVD 
ChemStation Agilent.

6 Si nécessaire, cliquez sur l’icône Agilent BootP Service... (Service BootP 
Agilent) dans la barre des tâches.

7 L’écran Welcome (Bienvenue) apparaît. Cliquez sur Next > (Suivant >).

8 Le contrat de licence s’affiche. Prenez-en connaissance, puis cliquez sur 
Yes (Oui) pour confirmer que vous l’acceptez.

9 Cliquez sur Install (Installer).

REMARQUE Si vous utilisez les communications réseau ou que vous passez d’une connexion GPIB 
à une connexion LAN, vous devez utiliser le service BootP Agilent avec la ChemStation 
(Rév. B.04.02) afin d’attribuer une adresse IP aux instruments qui ne peuvent pas le faire 
automatiquement. Le serveur BootP CAG n’est pas pris en charge. Avant d’installer le 
logiciel du service BootP Agilent, supprimez donc le serveur BootP CAG de votre 
ordinateur.
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10 Les fichiers se chargent, puis l’écran BootP Settings (Paramètres BootP) 
apparaît.

• Cet écran contient les paramètres par défaut non configurés. 
Ces paramètres seront saisis lors de la procédure de configuration.

• Servez-vous de l’utilitaire IPCONFIG pour vérifier les paramètres TCP/IP : 
ouvrez une fenêtre de commande et tapez ipconfig/all.

11 Cochez la case Do you want to log BootP requests? (Journalisation des requêtes 
d’amorçage).

Une fois les instruments configurés, la case Do you want to log BootP requests? 
(Journalisation des requêtes d’amorçage) doit être désactivée, sans quoi le 
fichier journal remplira rapidement l’espace disque.

12 Dans la zone Default Settings (Paramètres par défaut) de l’écran, saisissez le 
masque de sous-réseau ainsi que l’adresse de passerelle. Consultez votre 
administrateur réseau si vous ne connaissez pas ces informations.

• Le masque de sous-réseau par défaut est 255.255.255.0.

• La passerelle par défaut est 10.1.1.101.

13 Cliquez sur OK. L’écran Agilent BootP Service Setup (Configuration du service 
BootP Agilent) apparaît.

14 Cliquez sur Finish (Terminer) pour quitter l’écran Agilent BootP Service Setup 
(Configuration du service BootP Agilent).
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15 Retirez le DVD du lecteur.

L’installation est terminée.

Vous pouvez imprimer le fichier README du service BootP Agilent. Il se 
trouve sous C:\Program Files\Common Files\Agilent Shared\BootP\bin\
Readme.htm.

Attribution d’adresses IP aux instruments à l’aide du service BootP Agilent

Le service BootP Agilent gère l’association entre le code d’identification 
unique (adresse MAC) fourni avec la carte réseau installée sur un instrument 
donné et l’adresse IP attribuée à cet instrument. Par conséquent, la définition 
ou la redéfinition de cette association est indispensable chaque fois que vous 
ajoutez un nouvel instrument, que vous remplacez un instrument (ou sa carte 
réseau) ou que vous modifiez l’adresse IP attribuée à un instrument.

Configuration des instruments à l’aide du service BootP Agilent

1 Déterminez l’adresse MAC du CPG sur lequel est installée la carte JetDirect 
en utilisant soit :

• le service BootP Agilent (étape 2)

• une carte JetDirect (étape 3)

2 Pour utiliser le service BootP Agilent pour déterminer l’adresse MAC 
du CPG :

a Éteignez et rallumez le CPG.

b À la fin de l’auto-test du CPG, ouvrez le fichier journal dans le 
Bloc-notes. 

• L’emplacement par défaut du fichier journal est My Computer/Local 
Disk/Program Files/Common Files/Agilent Shared/BootP/bin/logfile.

• Le fichier journal n’est pas mis à jour s’il est ouvert.

• Attribuez une adresse aux seuls appareils qui ne peuvent pas le faire 
eux-mêmes. Pour plus d’informations, consultez la documentation de 
l’instrument.
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Le contenu doit se présenter comme suit :

02/25/04 15:30:49 PM 
Status: BootP Request received at outermost layer 
Status: BootP Request received from hardware address: 0010835675AC  
Error:   Hardware address not found in BootPTAB: 0010835675AC 
Status: BootP Request finished processing at outermost layer 

c Notez l’adresse MAC (par exemple 0010835675AC), également appelée 
adresse matérielle.

d Fermez le fichier journal avant d’allumer un autre instrument. 

e Passez à l’étape 4.

3 Pour utiliser une carte JetDirect pour déterminer l’adresse MAC du CPG :

a Éteignez l’instrument.

b Retirez la carte JetDirect.

c Lisez l’adresse MAC sur l’étiquette.

L’adresse MAC est imprimée sur une étiquette se trouvant sur le côté 
de la carte JetDirect où ne sont pas installés les composants. Il s’agit 
du numéro situé sous le code à barres, après les deux-points (:). 
Il commence généralement par les lettres AD. 

d Réinstallez la carte.

e Allumez le CPG.

4 Ajoutez le CPG au réseau.

a Sélectionnez Start > All Programs > Agilent BootP Service (Démarrer > 
Programmes > Service BootP Agilent), puis Edit BootP Settings (Modifier 
les paramètres BootP). L’écran BootP Settings (Paramètres BootP) 
apparaît.

b Désactivez la case Do you want to log BootP requests? (Journalisation 
des requêtes d’amorçage).

Une fois les instruments configurés, la case Do you want to log BootP 
requests? (Journalisation des requêtes d’amorçage) doit être désactivée, 
sans quoi le fichier journal remplira rapidement l’espace disque.

c Cliquez sur Edit BootP Addresses... (Edition des adresses d’amorçage...).

d Cliquez sur Add... (Ajouter...). L’écran Add BootP Entry (Ajout d’entrée 
BootP) apparaît.
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e Saisissez les éléments suivants pour le CPG :

• Adresse MAC

• Nom de l’hôte

• Adresse IP

• Commentaires, si nécessaire

• Masque de sous-réseau

• Adresse de la passerelle

f Cliquez sur OK.

g Quittez le gestionnaire BootP, éteignez et rallumez le CPG.

Si vous avez modifié l’adresse IP, vous devez éteindre et rallumer 
l’instrument pour appliquer les modifications.

h Lancez un ping sur l’adresse IP pour vérifier qu’elle fonctionne bien.

5 Ajoutez d’autres instruments ou appareils au réseau.

a Répétez l’étape 4 pour chaque instrument ou appareil réseau nécessitant 
le service BootP.

b Lorsque vous avez terminé, cliquez sur Close (Fermer).

c Cliquez sur OK.
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Configuration du service BootP Agilent

Le service BootP Agilent se lancera automatiquement au redémarrage de votre 
PC. Pour modifier les paramètres du service BootP Agilent, vous devez arrêter 
le service, effectuer les modifications, puis redémarrer le service. Procédez 
comme suit pour configurer votre service BootP Agilent.

Arrêt du service BootP Agilent

1 Dans le Control Panel (Panneau de configuration) de Windows, sélectionnez 
Administrative Tools > Services (Outils d’administration > Services). L’écran 
Services apparaît.

2 Cliquez avec le bouton droit sur Agilent BootP Service (Service BootP 
Agilent).

3 Sélectionnez Stop (Arrêter).

4 Fermez l’écran Services and Administrative Tools (Outils d’administration).
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Modification des paramètres

1 Sélectionnez Start > All Programs > Agilent BootP Service (Démarrer > 
Programmes > Service BootP Agilent), puis Edit BootP Settings (Modifier 
les paramètres BootP). L’écran BootP Settings (Paramètres BootP) apparaît.

2 La première fois que l’écran BootP Settings (Paramètres BootP) apparaît, 
il indique les paramètres par défaut définis lors de l’installation.

Création du fichier TabFile

Pour créer un nouveau modèle pour le fichier TabFile, sélectionnez Create 
Tab File (Créer fichier TabFile).

Le fichier TabFile créé par défaut lors de l’installation se trouve sous  
C:\Program Files\Common Files\Agilent Shared\BootP\bin\TabFile. Il 
contient les informations de configuration saisies sur cet écran.

Configuration du fichier journal

Cochez la case Do you want to log bootP requests? (Journalisation des requêtes 
d’amorçage) pour capturer toutes les demandes d’adresse MAC envoyées au 
CPG. Une fois les instruments configurés, désélectionnez la case Do you want to 
log bootP requests? (Journalisation des requêtes d’amorçage) pour éviter que le 
fichier journal ne prenne trop d’espace sur le disque.

Le fichier journal créé par défaut lors de l’installation se trouve sous  
C:\Program Files\Common Files\Agilent Shared\BootP\bin\logfile. Il 
contient une entrée pour chaque demande d’informations de configuration 
depuis BootP par un périphérique.

Redémarrage du service BootP Agilent

1 Dans le Control Panel (Panneau de configuration) de Windows, sélectionnez 
Administrative Tools > Services (Outils d’administration > Services). L’écran 
Services apparaît.

2 Cliquez avec le bouton droit sur Agilent BootP Service (Service BootP Agilent) 
et sélectionnez Start (Démarrer).

3 Fermez les écrans Services et Administrative Tools (Outils d’administration).

La configuration est terminée.
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Installation et configuration de la carte d’interface GPIB Agilent

Si vous n’utilisez pas les communications GPIB, ne tenez pas compte de cette 
section.

Installation et configuration de la carte d’interface GPIB Agilent

Pour installer la carte d’interface GPIB, consultez le manuel de votre 
ordinateur ou suivez les instructions ci-après.

1 Mettez hors tension et débranchez l’ordinateur, puis retirez son ou ses 
capot(s).

2 Sélectionnez un emplacement vide pour y insérer votre carte GPIB. Des 
interférences peuvent se produire au niveau du câble GPIB si la carte est 
placée dans le dernier emplacement du boîtier du PC.

3 Desserrez la vis de fixation et retirez la plaque arrière de l’emplacement 
libre choisi.

4 Insérez la carte dans son emplacement en la tenant par les bords. Veillez 
à ce que le connecteur plat de la carte soit engagé à fond. Bloquez la carte 
à l’aide de la vis de fixation.

5 Remettez en place le(s) capot(s) de l’ordinateur. Branchez l’ordinateur et 
remettez-le en marche.

6 Après avoir installé la carte GPIB sur l’ordinateur, vous devez installer le 
pilote et le logiciel de configuration correspondants, qui se trouvent sous 
le répertoire IO Library Suite du DVD ChemStation Agilent. Consultez le 
guide d’installation des bibliothèques E/S (Agilent IO Libraries Suite), 
qui se trouve également sur le DVD ChemStation, sous le dossier Support\
Manuals\Installation.

AVERTISSEMENT Débranchez votre ordinateur ainsi que tous les appareils électriques qui y sont 
reliés avant de retirer les capots. Veillez à utiliser un bracelet antistatique 
pendant l’installation de la carte GPIB.
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Câblage GPIB

Lorsque vous connectez plusieurs appareils GPIB, respectez les consignes 
suivantes :

• Dans la mesure du possible, mettez l’ordinateur hors tension et 
débranchez-le, de même que toutes les unités connectées, avant d’installer 
les câbles GPIB.

• Avant de connecter un instrument d’analyse quelconque à un câble GPIB, 
consultez la documentation correspondante et déterminez son adresse 
GPIB. Deux unités connectées à la ChemStation Agilent ne peuvent avoir 
la même adresse. Notez chaque adresse GPIB. Ces informations vous seront 
utiles ultérieurement.

• Si possible, utilisez des câbles GPIB d’une longueur maximale de deux 
mètres. 
 
Câble (0,5 m) (référence 10833D) 
Câble (1 m) (référence 10833A) 
Câble (2 m) (référence 10833B) 
Câble (4 m) (référence 10833C)

• Branchez une extrémité d’un câble GPIB au connecteur GPIB de 
l’ordinateur. Serrez correctement tous les connecteurs GPIB. 
Une connexion défectueuse peut provoquer des erreurs difficiles 
à diagnostiquer.

• Connectez les unités GPIB en chaîne. Une connexion « en chaîne » se 
compose d’une unité GPIB connectée à l’unité GPIB suivante, cette dernière 
étant elle-même connectée à la suivante, et ainsi de suite. Évitez les 
configurations « en étoile » (connexion de toutes les unités à un point 
central).

ATTENTION La ChemStation Agilent ne prend pas en charge les unités d’extension GPIB.
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Ce chapitre explique comment :

• Configurer votre PC pour installer le nouveau logiciel ChemStation Agilent

• Installer la ChemStation Agilent pour la première fois

• Afficher les licences des instruments lors de la première installation

• Ajouter une licence d’instrument à une ChemStation Agilent existante

• Mettre à niveau la ChemStation Agilent
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Avant de commencer

Avant d’installer votre logiciel ChemStation Agilent, configurez votre PC 
comme suit :

1 Vérifiez que votre PC répond aux exigences minimales.

2 Configurez les communications des instruments conformément aux 
instructions du Chapitre 1.*

3 Ouvrez une session Windows sur votre PC avec des privilèges 
d’administrateur.

4 Dans le Control Panel (Panneau de configuration), ouvrez Regional Options 
and Language Options (Options régionales et linguistiques). Sous l’onglet 
Regional Options (Options régionales), définissez la langue sur English (US) 
(Anglais (États-Unis)). Si vous utilisez une autre langue, les paramètres 
ci-dessous sont obligatoires :

• Symbole décimal = . (point)

• Symbole de groupement des chiffres = , (virgule) 

• Séparateur de liste = , (virgule)

Sous l’onglet Advanced (Options avancées), définissez la langue pour les 
programmes non-Unicode sur English (US) (Anglais (États-Unis)).

5 Désactivez les paramètres de gestion avancée de l’alimentation de votre 
ordinateur, tels que la mise en veille et la veille prolongée du système.

Pour plus de détails sur l’optimisation des performances sous Windows XP 
ou Windows Vista, reportez-vous aux instructions détaillées dans le document 
Configuration et gestion de l’ordinateur de votre ChemStation, disponible 
au format PDF sur le DVD ChemStation Agilent. Ce document décrit les 
paramètres système nécessaires pour optimiser les performances de la 
ChemStation Agilent.

* Ne s’applique pas au logiciel ChemStation Agilent de traitement des données.

REMARQUE Dans le cadre d’une mise à niveau de votre logiciel ChemStation Agilent, vous pourriez 
être amené à modifier le matériel ou le système d’exploitation avant d’installer le nouveau 
logiciel. Lisez attentivement le document Upgrade Preparation Guide for Agilent 
ChemStation B.04.02 (Guide de préparation à la mise à niveau pour ChemStation Agilent 
B.04.02) pour obtenir des instructions détaillées sur la préparation de votre PC à la mise à 
niveau. Ce document est disponible au format papier, ainsi que sous forme de fichier PDF 
dans le répertoire Manuals du DVD ChemStation Agilent.
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Procédure d’installation

Reportez-vous à la section correspondant au type d’installation à effectuer :

• « Installation initiale », page 29

• « Mise à niveau du logiciel (à la version B.04.02) », page 34

Installation initiale

Cette section décrit comment installer le logiciel ChemStation Agilent pour 
la première fois.

Pour ajouter un instrument à une ChemStation Agilent, reportez-vous à la 
page 35. Voir page 34 pour obtenir des instructions sur la mise à niveau ou 
la réinstallation du logiciel ChemStation Agilent.

Pour une première installation du logiciel ChemStation Agilent :

1 Vérifiez que vous avez bien effectué toutes les étapes indiquées dans la 
section « Avant de commencer », page 28.

2 Vérifiez qu’aucun programme n’est en cours d’exécution sur le système.

3 Avant de procéder à tout mise à niveau de la ChemStation, pensez à 
sauvegarder les méthodes, les séquences, les fichiers de données et les 
bases de données de colonnes (6890COL.MDB, CATALOG.MDB, 
6850COL.MDB et 6850CAT.MDB) vers un autre emplacement.

4 Insérez le DVD du logiciel ChemStation Agilent dans le lecteur de DVD. 

5 Dans le menu Start (Démarrer), sélectionnez Run (Exécuter).

6 Sur la ligne de commande, tapez lecteur:\Install\Setup.exe (soit par exemple, 
E:\Install\Setup.exe), puis cliquez sur OK. L’assistant d’installation démarre.

7 Acceptez les invites affichées par l’Assistant InstallShield pendant les 
premières étapes de l’installation.

• Il est préférable d’utiliser le répertoire par défaut (C:\Chem32) lorsque 
le système vous demande de choisir un répertoire d’installation pour la 
ChemStation Agilent.

REMARQUE Les bases de données de colonnes de la ChemStation pour système CPG figurent dans le 
dossier C:\Chem32\drivers.
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• Si Microsoft .NET Framework 2.0 n’est pas installé sur votre ordinateur, 
vous êtes invité à l’installer maintenant. Allez dans le répertoire dotNET 
Framework du DVD ChemStation et exécutez dotnetFx.exe pour 
l’installer immédiatement, puis recommencez les étapes 5, 6 et 7.

• Si Microsoft .NET Framework 3.5 SP1 n’est pas installé sur votre 
ordinateur, vous êtes invité à l’installer maintenant. L’installation de 
.Net 3.5 SP1 peut nécessiter un redémarrage de l’ordinateur.

• Vous pouvez être invité à installer le logiciel de l’imprimante PDF. Cette 
imprimante est indispensable : elle permet de générer des rapports au 
format PDF.

8 Configurez le nombre et le type d’instruments avec l’Assistant 
d’installation. Pour ajouter un instrument, cliquez sur l’un des boutons 
situés à gauche de l’écran.
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• Vous pouvez ajouter un maximum de quatre instruments en cliquant sur 
les boutons correspondants (notez que vous devez disposer d’une licence 
pour chacun de ces instruments). 

• Si vous sélectionnez un instrument de traitement des données après 
avoir sélectionné un instrument de CPG ou de CPL, toutes les sélections 
antérieures seront perdues.
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9 Après avoir ajouté les types d’instruments, saisissez les licences 
correspondantes.

Saisissez le numéro de licence approprié dans le champ correspondant, et 
cliquez sur Add (Ajouter). Le contenu du champ de texte s’efface et la clé 
apparaît en regard du nom de module affiché. Une seule licence complète 
est requise par type d’instrument.

Si vous saisissez des licences pour différents types d’instruments (par exemple 
des instruments de CPG, des convertisseurs A/N ou des instruments de CPL), 
notez que le type de licence saisi ici pour chaque instrument détermine les 
configurations possibles. Par exemple, si vous saisissez une licence CPG pour 
l’Instrument 1, celui-ci devra être configuré comme CPG.

10 Cliquez sur Finish (Terminer) pour terminer l’assistant d’installation. 
L’éditeur de configuration s’affiche automatiquement.

REMARQUE Si une licence non valide ou d’un type incorrect est saisie, le champ de texte s’affiche en 
rouge et un message d’erreur indique que la licence n’a pas été acceptée.

REMARQUE Il n’est pas nécessaire de redémarrer l’ordinateur.
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11 Remplissez les écrans de l’éditeur de configuration. Reportez-vous au 
Chapitre 3, « Configuration des instruments » pour connaître les procédures 
de configuration des instruments. 

12 Une fois les instruments configurés, sélectionnez File > Save (Fichier > 
Enregistrer).

13 Fermez l’éditeur de configuration.

14 Après avoir installé le logiciel et configuré les instruments, rangez 
soigneusement le DVD ChemStation et les numéros de licence. Ils seront 
indispensables si vous souhaitez réinstaller le logiciel ou ajouter un 
nouveau module d’instrument ou une nouvelle licence par la suite.
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Mise à niveau du logiciel (à la version B.04.02)

Si vous effectuez une mise à niveau depuis la version B.01.01 ou une version 
ultérieure de la ChemStation, reportez-vous au Guide de référence rapide 
pour la mise à niveau disponible dans le répertoire Manuals du DVD 
ChemStation Agilent. Avant toute nouvelle installation, prenez soin 
d’enregistrer les méthodes, les séquences, les fichiers de données et les bases 
de données de colonnes de chaque instrument.

Les bases de données de colonnes de la ChemStation pour système 
CPG figurent dans le sous-dossier drivers, soit par exemple dans  
C:\Chem32\drivers.

Activation de l’interface XML

Si vous utilisez un système de gestion de laboratoire (LIMS) ou d’autres 
systèmes de collecte de données externes, la ChemStation Agilent propose 
une interface XML qui permet de lire les listes d’échantillons, d’analyser les 
échantillons et de retransmettre les résultats au LIMS. Pour activer cette 
fonctionnalité, vous devez modifier le fichier CHEMSTATION.INI. Pour plus 
d’informations, reportez-vous au Guide de connectivité XML de la 
ChemStation Plus Agilent qui se trouve dans le répertoire \Support\Manuals 
du DVD ChemStation Agilent. 

REMARQUE Avant d’effectuer une mise à niveau, vous devez supprimer tous les correctifs et tous les 
logiciels complémentaires de la ChemStation. Reportez-vous au Guide de référence rapide 
pour la mise à niveau.
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Ajout d’instruments à une installation existante

Pour ajouter un instrument à une installation existante :

1 Sélectionnez Programs > Agilent ChemStation > Add Instrument (Programmes > 
Agilent ChemStation > Ajouter un instrument). L’assistant d’installation de 
la ChemStation démarre.

• Il est impossible de modifier ou de supprimer des instruments 
configurés.

• Une même installation de la ChemStation peut accepter jusqu’à quatre 
instruments.

2 Allez de l’étape 8 à l’étape 10 comme décrit à la page 30.

3 Exécutez l’outil IQT Report pour vérifier la ChemStation après avoir 
ajouté des instruments. Voir la section « Exécution de la procédure de 
validation IQT », page 55.
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Installation des rapports des graphiques de contrôle

L’opération suivante permet d’ajouter des graphiques de contrôle à votre 
menu de rapport.

Pour utiliser cette fonctionnalité, Microsoft Excel 2000, XP ou 2003 doit être 
installé sur votre PC.

Une fois la ChemStation Agilent installée et le système redémarré, vous 
pouvez installer la fonction de graphique de contrôle de la ChemStation.

1 Démarrez la ChemStation Agilent.

2 Localisez la ligne de commande ChemStation Agilent. La ligne de 
commande est un champ de saisie de texte situé dans la partie inférieure 
de la fenêtre de programme ChemStation Agilent.

3 À la ligne de commande, tapez MACRO STARTCHT.MAC,GO et appuyez 
sur Enter (Entrée).

4 Une boîte de dialogue contenant des informations sur l’installation 
apparaît.

5 Dans cette boîte de dialogue, cliquez sur Help (Aide) pour obtenir des 
informations sur l’utilisation des graphiques de contrôle avec votre 
ChemStation Agilent.

6 Cliquez sur OK pour installer la fonction de graphiques de contrôle sur votre 
ChemStation Agilent. 
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Ce chapitre explique comment utiliser l’éditeur de configuration pour 
configurer vos instruments de façon à ce qu’ils fonctionnent avec la 
ChemStation Agilent pour CPG, l’outil de traitement des données 
ChemStation et le convertisseur A/N 35900E. 
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À propos de l’éditeur de configuration ChemStation Agilent

L’éditeur de configuration ChemStation Agilent est un programme qui permet 
de configurer facilement votre logiciel ChemStation Agilent. Il permet 
notamment de :

• détecter l’interface GPIB de votre PC,

• sélectionner une communication LAN ou GPIB,

• configurer le matériel d’analyse connecté au PC,

• configurer le chemin utilisé pour l’enregistrement des méthodes, 
des données et des séquences,

• configurer l’affichage couleur de la ChemStation Agilent.

Vous devrez utiliser l’éditeur de configuration :

• comme dernière étape du processus d’installation initiale du logiciel 
ChemStation Agilent,

• chaque fois qu’un appareil GPIB est connecté au PC, modifié ou déconnecté 
du bus GPIB ou du PC,

• chaque fois que vous modifiez l’adresse IP d’un périphérique réseau, ou que 
vous ajoutez ou supprimez un périphérique réseau au logiciel ChemStation.

Après avoir installé le logiciel ChemStation Agilent, vous êtes invité à 
configurer entièrement le système d’analyse.
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Configuration de la ChemStation Agilent pour les systèmes CPG 
(7890A, 6890, 6850 et 5890/4890)

Après avoir installé le logiciel ChemStation, appliquez la procédure suivante 
pour permettre à la ChemStation Agilent d’identifier et de contrôler votre 
matériel.

1 S’il n’est pas encore lancé, démarrez l’éditeur de configuration : Start > 
All Programs > Agilent ChemStation > Configuration Editor (Démarrer > 
Programmes > Agilent ChemStation > Editeur de configuration). Dans 
l’écran d’ouverture de l’éditeur de configuration, mettez en surbrillance la 
barre de titre correspondant à l’instrument installé avec une licence CPG, 
puis sélectionnez Configure > Instruments (Configurer > Instruments). L’écran 
Select Instrument (Sélectionner l’instrument) apparaît. 

2 Sélectionnez le modèle d’instrument dans la liste Instrument Type 
(Type d’instrument), soit par exemple, 7890A GC (CPG 7890A). 
Notez les exceptions suivantes :

• Pour contrôler un CPG Agilent 6890 ou 6850 incluant un échantillonneur 
automatique de série 7683 ou 7673C, ou aucun échantillonneur 
automatique, sélectionnez 6890 GC (Classic) (CPG 6890 Classique) ou 
6850 GC (Classic) (CPG 6850 Classique).

• Pour contrôler un CPG Agilent 6890 ou 6850 intégrant un 
échantillonneur 7693A, sélectionnez 6890 GC (CPG 6890) ou 6850 GC 
(CPG 6850). 

Barre de titre

Configure > Instruments 
(Configurer > Instruments)
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• Pour contrôler un CPG 4890D, sélectionnez 5890 GC (CPG 5890). 

3 Acceptez le nom de l’instrument ou saisissez un nouveau nom dans le 
champ Instrument Name (Nom d’instrument). Le nom saisi apparaît dans la 
barre de titre lorsque vous utilisez la ChemStation Agilent.

4 Sélectionnez la taille d’écran initiale pour définir le mode d’ouverture du 
programme. 

5 Cliquez sur OK pour continuer. 

6 Remplissez les champs de l’écran Device Configuration (Configuration 
du périphérique).  

Précisez le type de connexion entre votre PC et l’instrument :

• LAN (IP) + adresse IP

• LAN (hôte) + Nom d’hôte

• GPIB + adresse GPIB 

Étape 2

Étape 3

Étape 4
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Pour certains types de CPG, il existe un champ Port Address (Adresse 
de port). Sauf instruction contraire, acceptez le numéro de port par 
défaut 9100.

7 Configurez les périphériques en option.

• Pour configurer un échantillonneur 7673 sur un CPG 5890/4890 : si 
un échantillonneur 7673 est relié à un CPG 5890/4890, sélectionnez 7673 
Sampler (Échantillonneur 7673) dans la zone Options, précisez l’adresse 
GPIB dans l’espace prévu et cliquez sur Add (Ajouter).
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• Pour configurer une interface bi-voie 35900E pour 1 ou 2 détecteurs 
CPG : si un convertisseur A/N 35900E est relié à un CPG 6890, 6850 ou 
5890 pour contrôler des signaux supplémentaires, sélectionnez 35900E 
dans la zone Options, cliquez sur Add (Ajouter), indiquez le type 
d’interface et les entrées de voie, puis cliquez sur OK. 

8 Cliquez sur OK dans l’écran Device Configuration (Configuration du 
périphérique) pour revenir à la fenêtre principale de l’éditeur de 
configuration, illustrée à l’étape 1.

9 Cliquez sur File > Save (Fichier > Enregistrer).

10 Cliquez sur File > Exit (Fichier > Quitter) pour revenir à Windows.
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Configuration de la ChemStation Agilent pour systèmes de traitement 
de données

Après avoir installé le logiciel ChemStation, procédez comme suit pour 
permettre à la ChemStation Agilent d’identifier et de contrôler votre système 
de traitement des données.

1 S’il n’est pas encore lancé, démarrez l’éditeur de configuration : Start > 
All Programs > Agilent ChemStation > Configuration Editor (Démarrer > 
Programmes > Agilent ChemStation > Editeur de configuration). Dans 
l’écran d’ouverture de l’éditeur de configuration, mettez en surbrillance 
la barre de titre correspondant à l’instrument concerné, puis sélectionnez 
Configure > Instruments... (Configurer > Instruments...). L’écran Select 
Instrument (Sélectionner l’instrument) apparaît. 

REMARQUE Pour les configurations de type Traitement de données seul, ne modifiez pas les paramètres 
par défaut dans l’éditeur de configuration, mis à part éventuellement le nom de 
l’instrument (étape 3). 
L’instrument 1 doit être défini comme étant un chromatographe en phase gazeuse 
(GC or A/D Data Analysis Only (Traitement de données CPG ou A/N seule)) et 
l’instrument 2 comme un chromatographe en phase liquide (LC Data Analysis Only 
(Traitement de données CPL seule)).

Barre de titre

Configure > Instruments 
(Configurer > Instruments)
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2 Dans la liste Instrument Type (Type d’instrument), sélectionnez GC or A/D 
Data Analysis only (Traitement de données CPG ou A/N seul).  

3 Acceptez le nom de l’instrument ou saisissez un nouveau nom dans le 
champ Instrument Name (Nom d’instrument). Le nom saisi apparaît dans la 
barre de titre lorsque vous utilisez le logiciel ChemStation Agilent. 

4 Sélectionnez la taille de la fenêtre du premier écran pour définir le mode 
d’ouverture du programme. 

5 Cliquez sur OK pour continuer. 

6 Cliquez sur File > Save (Fichier > Enregistrer).

7 Cliquez sur File > Exit (Fichier > Quitter) pour revenir à Windows.

Étape 2

Étape 3

Étape 4
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Configuration de la ChemStation Agilent pour systèmes d’interface 
A/N 35900E

Ce chapitre décrit comment configurer l’interface analogique/numérique 
35900E. Remarque : l’interface A/N 35900E nécessite le service BootP Agilent 
(voir la section « Installation du service BootP Agilent », page 17).

1 S’il n’est pas encore lancé, démarrez l’éditeur de configuration : Start > 
All Programs > Agilent ChemStation > Configuration Editor (Démarrer > 
Programmes > Agilent ChemStation > Editeur de configuration). Dans l’écran 
d’ouverture de l’éditeur de configuration, mettez en surbrillance la barre de 
titre correspondant à l’instrument installé avec une licence A/N 35900E, puis 
sélectionnez Configure > Instruments... (Configurer > Instruments...). L’écran 
Select Instrument (Sélectionner l’instrument) apparaît. 

2 Sélectionnez l’instrument 35900E ADC que vous souhaitez contrôler dans la 
liste Instrument Type (Type d’instrument).

Barre de titre

Configure > Instruments 
(Configurer > Instruments)

Étape 2

Étape 3

Étape 4
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3 Acceptez le nom de l’instrument ou saisissez un nouveau nom dans le 
champ Instrument Name (Nom d’instrument). Le nom saisi apparaît dans la 
barre de titre lorsque vous utilisez la ChemStation Agilent.

4 Sélectionnez la taille d’écran initiale pour définir le mode d’ouverture du 
programme. 

5 Cliquez sur OK pour continuer.

6 Sélectionnez le type d’interface, puis entrez l’adresse IP ou le nom d’hôte.

7 Pour la collecte de signaux par la ChemStation Agilent, sélectionnez la 
ou les voie(s) à utiliser. L’exemple précédent illustre une configuration 
à une voie (A). Pour plus d’informations, consultez le Manuel utilisateur 
du 35900E. 

8 Pour le contrôle d’un échantillonneur, cliquez sur Change (Modifier) dans la 
zone Sampler (Échantillonneur). Dans la boîte de dialogue Sampler 



Configuration des instruments 3

Installation de votre ChemStation 47

(Échantillonneur), sélectionnez le type d’échantillonneur Other (Autre) et 
complétez les autres zones de la boîte de dialogue. Cliquez sur OK.

9 Définissez les options External Start/Stop (Démarrage/arrêt externe) et 
Ready Status (État prêt). Pour accéder à la boîte de dialogue, cliquez sur 
Change (Modifier) dans la zone External Start/Stop (Démarrage/arrêt 
externe). Cette boîte de dialogue contient les options de démarrage/d’arrêt 
et d’état prêt du 35900.

a Sélectionnez une option applicable parmi les trois options de 
démarrage/arrêt proposées.

b Sélectionnez l’option d’état prêt qui convient.

• Cochez la case ChemStation displays status of ready signal (ChemStation 
affiche l’état du signal prêt) pour que la ChemStation Agilent affiche à 
l’écran le signal d’état d’exécution lorsque l’instrument est prêt.
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• Cochez la case ChemStation waits for ready signal (ChemStation attend le 
signal prêt) pour que la ChemStation Agilent attende le signal Prêt de 
l’instrument avant d’initier un processus automatique. 

c Pour revenir à la boîte de dialogue Device Configuration (Configuration 
du périphérique), cliquez sur OK.

10 Configurez les boutons du 35900. La boîte de dialogue 35900 Buttons 
(Boutons 35900) détermine si les boutons du panneau avant de l’interface 
35900 doivent permettre de démarrer ou d’arrêter une exécution manuelle. 
Pour accéder à la boîte de dialogue 35900 Buttons (Boutons 35900), cliquez 
sur Change (Modifier) dans la zone de groupe 35900 Buttons (Boutons 35900).

a Sélectionnez les options appropriées pour les boutons de marche/arrêt 
du 35900.

b Pour revenir à la boîte de dialogue Device Configuration (Configuration 
du périphérique), cliquez sur OK.

11 Vérifiez les événements programmés. Pour définir des événements 
programmés pour le 35900E, cliquez sur Change (Modifier) dans la zone 
de groupe Define Events (Définir des événements).

• Si vous utilisez le 35900E en mode Remote Bus (Bus distant) (paramètre 
par défaut), ne tenez pas compte de cette section. Elle ne s’applique pas 
à votre configuration.

• Si vous utilisez le 35900E en mode numérique E/S programmable, vous 
pouvez programmer 16 événements dans la ChemStation Agilent. 
Cependant, vous devez d’abord entrer l’EXPRESSION à utiliser pour 
définir chaque événement, conformément aux instructions ci-après.
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• Chaque expression définit l’état « actif » (par exemple, ouvert) et « inactif » 
(par exemple, fermé) de chaque instrument contrôlé avec le 35900E. Vous 
pourrez ensuite programmer ces événements en utilisant les expressions 
entrées dans la boîte de dialogue Defined Events (Événements 
programmés) de la ChemStation Agilent.

Dans l’exemple de la Figure 1, les broches 7 à 9 sont définies par 
l’utilisateur et les broches 2 à 6 correspondent aux paramètres par 
défaut.

Figure 1  Exemple d’écran de définition d’événements

ATTENTION La relation entre l’expression que vous attribuez et le numéro/l’état de la broche à 
laquelle elle est associée est enregistrée avec le fichier de définition de l’instrument. 
La méthode enregistre et utilise uniquement l’EXPRESSION proprement dite (par 
exemple, Close Valve1 (Fermer vanne1)). En conséquence, si vous copiez une méthode 
d’une ChemStation Agilent vers une autre, et que la seconde ChemStation Agilent 
possède une EXPRESSION d’événement correspondante mais des instruments 
différents, des résultats imprévisibles peuvent se produire. Vous devez donc être 
conscient que les associations que vous établissez entre un instrument et une 
EXPRESSION d’événement sont propres à votre configuration matérielle.
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a Saisissez l’EXPRESSION que vous souhaitez utiliser pour définir l’état 
désactivé (haut) et l’état activé (bas) du premier instrument. Toutes les 
combinaisons de chiffres et de lettres (20 au maximum) sont autorisées. 
 
Par exemple, si vous devez contrôler une vanne normalement fermée 
(une vanne qui ne s’ouvre que lorsqu’elle est alimentée), vous pouvez 
attribuer une expression telle qu’illustrée à la Figure 1 page 49. Cette 
expression indique que la vanne est normalement fermée (l’état Haut est 
fermé) et qu’elle passe à l’état ouvert (l’état Bas est ouvert) lorsqu’elle 
est alimentée. 
 
Vous pouvez aussi attribuer une expression plus explicite, telle que Close 
Nitrogen Valve (Fermer vanne d’azote) et Open Nitrogen Valve (Ouvrir vanne 
d’azote).

b Répétez la procédure décrite à l’étape (a) pour chaque instrument 
supplémentaire à contrôler.

c Pour revenir à la boîte de dialogue Device Configuration (Configuration 
du périphérique), cliquez sur OK.

12 Vérifiez que les informations affichées dans cette boîte de dialogue sont 
correctes. Pour modifier l’une de ces sélections, cliquez sur Change 
(Modifier) dans la zone de groupe appropriée.

13 Quittez la boîte de dialogue Device Configuration (Configuration du 
périphérique). Pour revenir à l’écran principal de l’éditeur de 
configuration, cliquez sur OK.

14 Enregistrez la nouvelle configuration d’instrument. Sélectionnez File > Save 
(Fichier > Enregistrer). 

15 Si vous devez configurer d’autres instruments, sélectionnez l’instrument 
concerné et continuez. S’il s’agit de votre seul instrument, sélectionnez 
File > Exit (Fichier > Quitter).
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Modification des chemins d’accès aux fichiers de méthodes, 
de séquences et de données

L’éditeur de configuration vous permet de spécifier des chemins d’accès 
différents pour vos instruments, séquences, méthodes, fichiers de données 
et macros. Vous pouvez ainsi enregistrer les fichiers de données sur un lecteur 
distinct.

Procédez comme suit pour configurer les différents chemins d’accès à un 
instrument.

1 Avant de modifier les paramètres de chemin d’accès à l’aide de l’éditeur 
de configuration, créez les autres répertoires.

2 Mettez en surbrillance la barre de titre de l’instrument à modifier.

3 Choisissez Paths (Chemins d’accès) dans le menu Configuration. Dans la 
boîte de dialogue qui s’ouvre, sélectionnez le type de fichier à modifier pour 
l’instrument concerné : fichiers de séquence, fichiers de données, 
méthodes, chemin d’accès aux macros ou chemin d’accès à l’instrument.

4 Dans le champ New Path (Nouveau chemin d’accès), modifiez le chemin 
puis cliquez sur Enter (Entrée).

• Tous les chemins d’accès doivent se terminer par le signe « \x11 » (barre 
oblique renversée).

• Répétez la procédure pour chaque chemin d’accès.

5 Cliquez sur OK pour mettre à jour les informations des chemins d’accès et 
revenir à l’éditeur de configuration.

Le Tableau 4 ci-dessous reprend indique les chemins d’accès par défaut.

Tableau 4 Chemins d’accès par défaut aux fichiers de données

Paramètre Chemins d’accès par défaut

Fichiers de séquence C:\CHEM32\1\SEQUENCE\

Fichiers de données C:\CHEM32\1\DATA\

Méthodes C:\CHEM32\1\METHODS\

Macros C:\CHEM32\CORE

Instruments C:\CHEM32\1\
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Ce chapitre décrit le fonctionnement de l’utilitaire IQT (Installation 
Qualification Report) de la ChemStation Agilent, qui permet de vérifier 
l’installation et les performances de la ChemStation Agilent sur votre PC. Il 
explique également comment commencer à utiliser la ChemStation Agilent 
une fois l’installation validée.
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Application IQT (Installation Qualification Report)

Après avoir installé la ChemStation Agilent sur l’ordinateur et avoir configuré 
le système d’analyse chimique, vous pouvez lancer une procédure de 
validation interne pour vérifier que l’installation est correcte et complète, et 
que le système d’analyse est totalement opérationnel. L’utilitaire IQT vérifie 
les codes de version des fichiers système exécutables de la ChemStation 
Agilent (*.EXE et *.DLL) et des fichiers de référence.

Il utilise les fichiers de référence d’installation paramétrés en usine pour 
vérifier l’existence, l’exactitude et l’intégrité des fichiers système ChemStation 
Agilent requis (fichiers programmes exécutables, fichiers de registres 
binaires, fichiers de macros, fichiers d’initialisation, fichiers d’aide et modèles 
de rapports personnalisés). 

L’intégrité des fichiers est vérifiée en comparant le total de contrôle croisé de 
redondance cyclique (CRC) du fichier installé avec celui du fichier original 
enregistré sur le master dinstallation fourni par Agilent Technologies. 
Les détails de ce fichier figurent dans des fichiers de référence. Les fichiers 
modifiés ou endommagés présentent des totaux de contrôle différents et sont 
donc détectés par l’utilitaire IQT.

Les totaux de contrôle permettent aussi de vérifier l’intégrité des fichiers de 
référence eux-mêmes. Dans le cas où l’utilitaire IQT est fourni avec un fichier 
de référence modifié après sa génération, cet état est signalé dans le rapport 
sous la section invalid reference files (fichiers de référence erronés).

Comme pour toute mise à niveau importante de votre logiciel ChemStation, 
Agilent vous recommande de générer un rapport de qualification 
d’installation (IQT) complet et de procéder à une qualification 
opérationnelle/vérification de performances (OQ/PV) après l’installation de la 
version B.04.02, pour vous assurer que l’installation est correcte et complète.
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Exécution de la procédure de validation IQT

L’utilitaire IQT de la ChemStation Agilent est installé automatiquement 
avec les fichiers de référence IQT nécessaires.

Pour effectuer la validation :
1 Vérifiez que le logiciel ChemStation Agilent est fermé avant d’exécuter 

l’utilitaire IQT.
2 Cliquez sur Start > All Programs > Agilent ChemStation > IQT Report 

(Démarrer > Programmes > Agilent ChemStation > Rapport IQT).

Le calcul du total de contrôle pour l’ensemble des fichiers système de la 
ChemStation Agilent peut prendre plusieurs minutes. 

3 L’utilitaire IQT de la ChemStation Agilent génère un fichier html contenant 
les résultats de la qualification (iqtreport.htm), dans le répertoire principal 
de la ChemStation (soit généralement c:\chem32). Ce rapport s’affiche 
automatiquement à l’écran dans le navigateur Internet du système. Dans le 
cas d’une installation complète et cohérente, la qualification de 
l’installation ne produit aucun message d’erreur et ne signale aucun fichier 
manquant ou modifié. Le rapport peut être imprimé à partir du navigateur.

Rapport de qualification de l’installation

Le rapport IQT présente les catégories de fichiers repris dans le Tableau 5 :

Tableau 5 Catégories de fichiers indiquées par l’application IQT 

Catégorie de fichier Description Action requise

Fichiers identiques Les fichiers requis sont présents et ont 
réussi avec succès le contrôle de 
version et d’intégrité.

Aucune action requise.

Fichiers manquants Des fichiers nécessaires au 
fonctionnement de la ChemStation 
Agilent sont manquants.

Réparez ou réinstallez la 
ChemStation Agilent.
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La Figure 2 et la Figure 3 donnent des exemples de résultats de la procédure 
IQT. Dans la Figure 2, l’installation a réussi de manière acceptable. Dans la 
Figure 3, l’installation n’a pas réussi car un fichier est manquant et un autre 
a été modifié.

Fichiers modifiés Des fichiers ont été endommagés ou 
modifiés.*

Réparez ou réinstallez le logiciel 
ChemStation Agilent, sauf si vous 
avez volontairement personnalisé 
ou mis à jour certains fichiers. 

Fichier de référence 
incorrect

Le fichier de référence original est 
endommagé ou a été modifié après sa 
création.

Réinstallez le fichier de référence 
d’origine.

* Si, avant de mettre à jour la ChemStation Agilent, vous n’avez pas supprimé tous les compléments 
logiciels, la procédure IQT échouera. Vous devez d’abord supprimer les compléments 
conformément aux instructions fournies dans le Guide de référence rapide pour la mise à niveau. 
Ce guide se trouve dans le répertoire Manuals du DVD ChemStation Agilent. Réparez ensuite, ou 
réinstallez, la ChemStation.

Figure 2 Exemple de rapport IQT, aucune erreur

Tableau 5 Catégories de fichiers indiquées par l’application IQT (suite)

Catégorie de fichier Description Action requise
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Figure 3 Exemple de rapport IQT, erreurs
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Qualification opérationnelle/vérification de performances (OQ/PV)

Le service OQ/PV d’Agilent fournit des résultats documentés attestant que 
votre nouveau logiciel ChemStation fonctionne conformément aux paramètres 
de performances établis. Il vérifie le fonctionnement de l’algorithme de 
l’intégrateur dans le cadre des tests de vérification de chromatographie. 
D’autres aspects importants sont couverts, notamment la communication et 
le contrôle de l’instrument, ainsi que la sécurité des données et les contrôles 
d’accès.

Pour vérifier que la ChemStation fonctionne selon les paramètres de 
performances établis, ouvrez la vue Traitement des données de votre 
application ChemStation et sélectionnez View > Verification > Run Test (Afficher 
> Vérification > Exécuter le test). Le test de vérification du système s’exécute 
automatiquement.

• Sélectionnez Run Test (Exécuter le test) à partir de la vue Verification 
(Vérification) et lancez la procédure du test de vérification intitulée default.val.

• Pour plus d’informations, reportez-vous à la rubrique consacrée aux tâches 
analytiques dans l’aide en ligne.
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Ce chapitre décrit les ressources ChemStation Agilent supplémentaires 
disponibles sur le DVD ChemStation Agilent ou sur www.agilent.com/chem.
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Centre de Contact Client Agilent Technologies 

Les services d’assistance permettent de résoudre les problèmes et 
d’optimiser les prestations

Avec le réseau Agilent de Centres de Contact Client, vous avez accès à des 
spécialistes qui pourront vous aider à résoudre vos difficultés d’exploitation 
et qui proposent assistance et conseils pour l’exécution des logiciels d’analyse 
Agilent. Le plus souvent, il s’agit d’une assistance téléphonique, mais elle peut 
aussi être fournie via un modem, avec votre autorisation. 

L’assistance logicielle d’une année proposée peut être prolongée de deux ans 
à des tarifs très compétitifs. Cette assistance vous donne droit à une aide 
téléphonique, aux mises à niveau disponibles et à l’envoi régulier de bulletins 
d’informations sur l’état des logiciels. Vous y trouverez des informations 
importantes sur les problèmes connus et les solutions proposées pour votre 
logiciel d’analyse Agilent. Pour savoir comment souscrire à ces services, 
adressez-vous à votre représentant local du service clientèle analytique.

Il vous fournira également des informations sur les services disponibles en 
matière de conseil, de personnalisation, de développement et de formation 
aux logiciels d’analyse Agilent.

Les services d’assistance et de mise à jour Agilent sont soumis aux tarifs 
et aux conditions en vigueur dans votre pays au moment où vous passez 
commande.
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Joindre le Centre de Contact Client LSCA Agilent Technologies

Lorsque vous appelez le Centre de Contact Client Agilent Technologies, soyez 
devant l’ordinateur et ayez la documentation du produit à portée de main.

Les éléments suivants pourront vous être utiles :

• L’étiquette de la pochette d’enregistrement comportant le numéro du 
produit, le code de la version, ainsi que le numéro de licence de votre 
logiciel d’analyse

• La formulation exacte des messages d’erreur émis par le système

• Une impression complète des informations système Windows

• Une description de la séquence d’opérations ayant conduit à la panne
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Contenu du DVD ChemStation Agilent

Le DVD ChemStation Agilent contient des informations supplémentaires 
actualisées susceptibles de vous intéresser lorsque vous installez votre 
système. Si nécessaire, consultez les documents suivants pour en savoir plus.

Modules de la ChemStation Agilent

Le DVD contient les fichiers exécutables pour tous les modules appartenant 
à la famille ChemStation Agilent. Pour installer un module, vous devez fournir 
le numéro de licence qui vous a été attribué pour ce module. Ces numéros 
permettent de « déverrouiller » le DVD normalement protégé. Vous les 
trouverez dans les pochettes d’identification jointes aux nouveaux produits. 
Ils constituent votre preuve d’achat d’une licence.

Dans le cas d’une première installation des modules de la ChemStation 
Agilent, vous trouverez dans le répertoire racine du DVD ChemStation Agilent 
un raccourci vers le programme d’installation principal (setup.exe). Pour 
ajouter des modules supplémentaires par la suite, cliquez sur Start > All 
Programs > Agilent ChemStation > Add Instrument (Démarrer > Programmes > 
ChemStation Agilent > Ajouter un instrument).

Bulletin d’informations sur l’état des logiciels de la ChemStation Agilent

Le bulletin d’informations sur l’état des logiciels (SBS) est un document 
reprenant les résultats des procédures Agilent de consignation, de suivi 
et de correction des défaillances. Ce bulletin se trouve dans le répertoire 
Support\SSB du DVD ChemStation Agilent.

Si vous disposez d’un contrat logiciel, vous recevrez automatiquement le 
bulletin d’informations sur l’état des logiciels ChemStation Agilent.

Historique des versions de la ChemStation Agilent

L’historique des versions est destiné aux utilisateurs devant revalider leur 
système de données analytiques après le passage à une nouvelle version du 
logiciel d’application. L’historique des versions concerne tous les produits 
de la famille ChemStation Agilent.

Les fichiers de l’historique se trouvent dans le répertoire Support\History 
du DVD ChemStation Agilent.

La première rubrique de l’aide en ligne dresse l’inventaire des modifications 
apportées.
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Bibliothèque des utilisateurs

Cette bibliothèque vise à aider les utilisateurs à développer et à personnaliser 
les installations en fonction de leurs besoins spécifiques, afin d’optimiser leur 
investissement.

La bibliothèque est alimentée par Agilent en interne, et par les contributions 
des utilisateurs. Pour chaque contribution, la fonctionnalité est vérifiée, sans 
toutefois passer par autant de procédures de test que pour le produit même. 
Par conséquent, Agilent Technologies ne garantit pas le bien-fondé des 
contributions.

La bibliothèque des utilisateurs comprend des utilitaires et des macros. 
Chaque contribution est fournie avec un fichier README.TXT spécifique, 
consultable dans n’importe quel éditeur de texte.

Bibliothèques E/S pour interface GPIB Agilent

Le DVD ChemStation Agilent contient la version des bibliothèques E/S testées 
avec succès sur la nouvelle version de la ChemStation Agilent. Les 
bibliothèques d’E/S doivent être installées séparément pour pouvoir être 
utilisées avec les instruments GPIB, selon la procédure décrite dans le guide 
Instructions d’installation et de configuration des bibliothèques E/S Agilent 
suite 15.0 ou version supérieure.

Service BootP Agilent

Le DVD ChemStation Agilent contient le programme d’installation du service 
BootP Agilent qui vous permet de fournir aux instruments d’analyse reliés 
au réseau local une adresse IP, ainsi que des paramètres de configuration. 
Le service BootP Agilent est facile à configurer pour l’utilisation d’instruments 
d’analyse en réseau. Pour plus d’informations sur le service BootP, 
reportez-vous à la section « Installation du service BootP Agilent », page 17.

Documentation des produits constitutifs de la ChemStation Agilent

Les produits constitutifs de la ChemStation Agilent sont fournis avec des manuels 
papier apportant des informations de référence, ainsi qu’une documentation en 
ligne organisée par tâches. Une version électronique de tous les manuels 
ChemStation est également disponible dans le répertoire Manuals du DVD.
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Produits de formation

Une large gamme de produits d’apprentissage est fournie avec votre logiciel 
ChemStation Agilent, le PC et les instruments. 

Documents

• Ce manuel d’installation, entre autres, décrit comment préparer votre 
ChemStation Agilent en installant le matériel et les logiciels nécessaires. 
Les manuels d’installation sont propres aux différents modules que peut 
contenir la ChemStation Agilent. Vous pouvez en recevoir plusieurs.

• Le manuel Comprendre votre ChemStation présente les concepts de 
la ChemStation Agilent pour vous aider à mieux comprendre son 
fonctionnement.

• Le manuel de macroprogrammation en ligne explique comment utiliser les 
différentes commandes pour personnaliser et étendre les capacités de votre 
ChemStation Agilent. Dans le menu Help (Aide), sélectionnez Commands 
(Commandes) pour accéder à ce manuel en ligne.

• L’interface XML est documentée de manière détaillée dans le Guide de 
connectivité XML ChemStation Agilent Plus, disponible sous forme de 
document PDF dans le dossier Manuals du DVD ChemStation Agilent.

Informations connexes de configuration et de maintenance

• Le fichier readme contient des informations à propos de différents aspects : 
ajout de nouvelles fonctions, solutions de contournement connues et 
correctifs n’ayant pas pu être apportés à ce manuel lors de l’impression. 
Pour consulter le fichier readme.txt, cliquez sur Start > All Programs > 
Agilent ChemStation > readme.txt (Démarrer > Programmes > ChemStation 
Agilent > readme.txt).

• Un journal mis à jour automatiquement contient toutes les erreurs 
rencontrées en cours de fonctionnement, ainsi que les éventuelles mesures 
correctives prises. Pour y accéder, sélectionnez Logbook (Journal) dans le 
menu View (Affichage), puis double-cliquez sur les entrées. Les dernières 
entrées apparaissent en début de liste.
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Système d’aide de la ChemStation Agilent

Le système d’aide de la ChemStation Agilent fournit une importante base 
de données sur les thèmes suivants :

• Le ChemStation Tutorial (Didacticiel ChemStation) propose un aperçu 
du logiciel et des tâches courantes, pour vous aider à vous familiariser avec 
le système.

• Le document How to work with your ChemStation (Comment travailler 
avec votre ChemStation) contient un ensemble d’instructions relatives 
à l’utilisation de la ChemStation Agilent. Vous apprendrez à contrôler 
les méthodes et l’exécution, à traiter les données, à mettre en page des 
rapports, à vérifier l’installation (OQ/PV) et à visualiser des diagnostics.

• Le document User Interface Reference (Référence de l’interface utilisateur) 
contient une description détaillée de tous les éléments des menus, barres 
d’outils et boîtes de dialogue du logiciel ChemStation Agilent. Les 
descriptions sont triées selon les différentes vues ChemStation Agilent. 

• Le document Concepts of ChemStation (Concepts de la ChemStation) 
contient des informations sur certains concepts particuliers du logiciel 
ChemStation Agilent, notamment l’intégration, l’étalonnage, les types 
de rapports, le traitement des spectres et les paramètres de pic.

• Le document Error Messages (Messages d’erreur) reprend tous les 
messages d’erreur susceptibles d’apparaître sur les instruments et en 
décrit les causes possibles et les éventuelles actions correctives. 

• Le document Troubleshooting (Dépannage) fournit des informations 
destinées à vous aider à résoudre les problèmes les plus fréquents 
rencontrés dans la ChemStation Agilent.

• Le document Commands (Commandes) dresse la liste de toutes les 
commandes, ainsi que les noms, groupes, syntaxes, paramètres, 
discussions, valeurs de retour et (si possible) des exemples des différentes 
tâches du logiciel ChemStation Agilent.

• Le document Macros contient le Guide de macroprogrammation, qui 
explique l’objectif et la structure de base des macros, ainsi que la manière 
de rédiger des macros à l’aide de chaînes de commande. Les macros vous 
permettent d’adapter le logiciel ChemStation Agilent en fonction de vos 
besoins.
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Logiciel Agilent Lab Advisor

Le logiciel Lab Advisor Agilent propose une mine d’informations 
complémentaires en ligne, de vidéos, d’ouvrages, etc.

Il propose des méthodes automatisées pour la gestion des laboratoires 
modernes. En plus de proposer des vidéos et documents relatifs au matériel, 
il peut :

• surveiller plusieurs instruments d’analyse en temps réel,

• se charger du suivi de la maintenance ordinaire,

• vous signaler les opérations de maintenance nécessaires avant que 
des problèmes ne surviennent,

• effectuer des tests de diagnostic et des étalonnages.

Plus d’informations

Pour plus d’informations, consultez le site web Agilent à l’adresse 
www.agilent.com/chem.
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